
6 PAVEMENT MARKING PLANS 

OBJECTIVE 

The objective of this chapter is to create Proposed Pavement Marking Features using the Design and Computation 

(D&C) Manager, FDOT Menu and GEOPAK tools. 

INTRODUCTION 

This section introduces several applications that help to create a Pavement Marking set of plans:  

• D&C Manager A GEOPAK tool used to help designers draw elements, set symbology, and 

compute quantities.  The FDOT CADD office provides a database set up with the correct symbology, cells, 

formulas and pay items needed to meet the FDOT standards. 

• Pavement Marking Program A set of tools within the Design & Computation (D&C) Manager used 

to draw in pavement markings in accordance with the FDOT Computer Aided Drafting and Design 

(CADD) standards.  

• Draw Cell Group by Feature A tool to place multiple cells along elements or alignments.  It uses the 

D&C Manager to insure the placement of cells, arrows and messages is with the correct symbology and 

pay item information for calculations. 

Note Refer to in the Plans Preparation Manual, Volume 2, Chapter 23 for more detail on developing the 

Signing and Marking set of plans. Refer to the Design Standards indexes for design criteria. 

EXPLORING D&C MANAGER 

The D&C Manager uses a proprietary DDB provided by FDOT. The installation of the FDOT CADD software places 

the latest D&C Manager DDB either on the server or on the local hard drive. For new projects, FDOT recommends 

to copy the latest DDB file from the FDOT installation folder into the project SYMB folder and rename it to the 

eleven-digit Financial Identification Number (FIN) number.  For the 

22049555201 project used as the example in this manual, the 

FDOTSS4.ddb is renamed to 22049555201.ddb. This allows the 

designer to modify the DDB for specific parameters, and protects it 

from any future maintenance updates overwriting the file. The latest 

FDOT DDB file is located in the \FDOTSS4\GEOPAK\databases\ 

folder.  The naming format is fdot####.ddb where #### is the year or 

version of the FDOT CADD Software.  

It is highly recommended that every user that works on projects 

becomes very familiar with D&C Manager. D&C Manager sets 

symbology and automates quantity calculations for linear, each, and 

area quantities. 



FDOT specifically set the DDB to create elements with the correct level symbology according to the FDOT CADD 

Standards. The DDB file is set up with discipline folders called categories. Inside of each category are items.  

• Categories - The basic component of the hierarchical tree is the Category, represented by a folder icon. 

The categories in the FDOTSS4.ddb are divided by discipline. The figure above shows the Categories with 

a description relative to their discipline  

• Items - The other DDB component is the item. An item could be a drafting item, a compute item or a 

default item. Items contain specific functions related to defined element symbology or quantity 

calculations. Items are represented by one of three icons: 

•  Default Icon -These items are used to set drafting standards for MicroStation commands or to 

draw COGO elements without annotation.  

•  Drafting Standards Icon - These items are used to set drafting standards for MicroStation 

commands or to draw COGO elements with annotation. 

•   Calculator Icon - These items are used to set drafting standards for MicroStation commands, to 

draw COGO elements and/or compute quantities. FDOT tags graphics with a pay item attribute for 

additional stratification of features when running computations and defines computation for these items. 

D&C MANAGER MENU BUTTONS 

D&C Manager has a toolbar for easy access of different modes. Summarized below are the functions of each 

button. A later section in this chapter covers in more detail the tools used to create Pavement Marking plans. 

 

 - Switch To Toolbox Mode. D&C Manager is set up to work in two different modes, as a dialog or a 

toolbox. This button activates the resizable and dockable toolbox.  To change the display back to the whole dialog, 

click the Switch to Dialog Mode button. The Place Influence check box is at the left end of the toolbox.  

 - Identify Item. The Identify Item button sets the D&C Manager item to match a selected MicroStation 

element previously drawn by the D&C Manager or elements drawn with Graphical COGO and the SMD file. If 

the item you ID does not match an item in the active DDB, a message appears in the status bar saying: No 

matching database item.  



 - Display. The Display button filters the display of MicroStation elements in the design file so only the 

selected features display, highlighted or hidden. This button expands D&C Manager to show a collection bin. 

This collection bin is for controlling the display of multiple items at one time. To add items to the collection bin, 

double-click the item. This tool also opens a second toolbox with four buttons as seen in the figure below.  

Buttons from left to right: Normal Display, Highlight Selection, Hide Selection and Display Only Selection. 

  

 - Design. The Design button plots COGO and MicroStation elements into MicroStation with the defined 

symbology when selecting Place Influence. Draw Plan and Profile dialog or MicroStation commands place 

elements.  

 

 - Set. The Set button sets the symbology of previously drawn MicroStation graphic elements in accordance 

with the parameters of a selected item in the DDB. This tool fixes elements to meet CADD standards or 

attach/modify Adhoc Attributes. 

 

 - Compute. The Compute button tabulates quantities of items placed as a Pay Item by use of the Design or 

Set mode or have been drawn in MicroStation and they match the search criteria of the ddb file. This tool also 

expands D&C Manager to show the collection bin; this allows you to process multiple pay items or categories 

at one time. A second toolbox opens with the computation results.  

  



 - Shapes. The Shapes button uses plan view MicroStation graphics that defines an enclosed area to create 

a filled shape for computing area quantities.  

Note FDOT does not recommend this tool is for use when the Civil Tools have been used for the design.  Use 

the Create Region tool instead with the Associative Region Boundary option toggled OFF. 

 - Pavement Marking. This mode provides additional options for placing pavement striping and markings. 

This tool adds four additional tools to D&C Manager as shown in the figure below.  

The four tools from left to right:  Striping, Separation, Chevron Diverge, and Chevron Merge: 

 

 - Preference. This expands the toolbar to include four additional buttons to configure D&C Manager. 

These tools are also accessible from the Edit menu. 

DESIGN SETTINGS 

Before using D&C Manager to draw or compute items, address settings. These are the Design Settings loaded 

from the Settings > Design menu in D&C Manager. 

 

• Maximum GAP Tolerance – If the distance between two specified elements in a MicroStation file is 

smaller than the Max Gap Tolerance, the software assumes the two elements intersect and act accordingly. 

If the distance is larger than the Max Gap Tolerance, GEOPAK assumes the two elements do not connect. 

• Deduction Tolerance – The Compute mode utilizes the Deduction Tolerance. For example, if the pay 

item is specified for a curb line, and for each manhole (drawn in as a cell), there is a deduction of six feet. 

The origin of the cell does not have to be on the curb line, but must be within the deduction tolerance in 

order to recognize cells and make the deduction. 



• Custom Line Style Creation – The Custom Line Style Scale Factor sets a specific scale for custom line 

styles. Note this scale is only for custom line styles.  

• Cell Creation – Plot Scale is a ratio with the Creation Scale within the setup of D&C Manager. If the 

Cell Creation Scale is 10 and the designer wants the cell twice as large as a cell placed with D&C Manager, 

utilize 20 as the Drawing Scale. 

Note When entering a drawing scale, all subsequent cells placed from the D&C Manager are scaled 

accordingly if the item is set to use creation scale. When placing a cell with place influence on, 

GEOPAK utilizes the drawing scale setting to compute an X & Y scale for use in the MicroStation 

Place Cell dialog.  

• Influence Graphic Cell Level Symbology – When active, GEOPAK utilizes the symbology within the 

D&C Manager, ignoring the element symbology defined in the cell. 

DESIGN MODE 

Design Mode is the default mode when the D&C Manager opens. The following functions use the Design Mode:  

• Set Drafting Standards by use of the Place Influence command for the placement of MicroStation elements 

using MicroStation commands. 

• Print COGO elements into the design file according to the drafting standards set by the item’s defined 

parameters. 

• Place Adhoc Attributes on an element. 

Whether placed in the file by generic MicroStation commands or plotted from COGO, Draw Plan & Profile, the 

items can be placed as pay items for future tabulation.  

By selecting Place Influence, the designer can use MicroStation commands to place elements utilizing the 

element attributes established for the currently selected item in the GEOPAK D&C Manager DDB. With most 

items, a GEOPAK attribute is placed with the element.  This attribute provides another identifier to make the 

element unique and used to sort features for calculating quantities.  

 

When selecting Place influence, the MicroStation level symbology is set. Any MicroStation command to draw 

a line, copy a line or place a cell is set to this symbology. 

 

Note When finished placing the elements for a selected item it is important to remember to turn off Place 

Influence. 

  



ADHOC ATTRIBUTES  

An Adhoc Attribute is additional information about a particular element. Look at it as another property for the 

MicroStation element, i.e.  Level, Color, Weight, and Style. 

By placing an Adhoc on the line, the designer is giving that line additional information. That information could 

be a chain name, cross slope, profile name, thickness, etc. It is almost limitless as to what can be associated to an 

element with Adhocs. Other down-stream applications use these Adhocs. 

Some Adhocs are placed in the background and the designer does not interact with them. For example, when a 

proposed & remove sign post is placed with the Draw Sign Program, a 3pc file is utilized to access the D&C 

Manager DDB to place Adhocs on the post symbol for computing quantities.  

The figure below shows the Adhocs that are associated with an item from D&C Manager. These Adhocs are part 

of the item and are set by default. Nothing indicated this information was set since all of the adhocs are locked 

for modification when placing elements.  

 

Other Adhocs are interactive meaning the designer must fill in the parameters. An example is placing guardrails. 

There are adhocs added to the line that must be defined by the designer.  

 

Note Adhocs with values displayed in red are locked for modification. 

Adhoc Attributes are comprised of three types of information that must be defined:  

• Name - The Name is an identifying term used when GEOPAK is searching for a specific Adhoc Attribute. 

• Type - The Type identifies the nature of the information, and has various options: Numeric, String, Unit, 

Quantity, and Remarks. 



• Value - The Value is the actual information used by GEOPAK, and is determined by the Type. For 

example, if the Type setting is Numeric then the Value must be a number and GEOPAK will use it as a 

number. 

DRAWING PAVEMENT MARKINGS 

 

Many of the Traffic Plan items are simple cells or line styles drawn and quantified using the D&C Manager. The 

Pavement Striping component of the D&C Manager facilitates the production of pavement striping plans. To draw 

pavement markings with the GEOPAK’s Pavement Marking program, select the pay item then click on the 

Pavement Marking button from the D&C Manager dialog. After selecting the Pavement Marking button, D&C 

Manager displays additional Pavement Marking options.  

Note As a best practice, start the pavement marking design by placing one of the solid edge lines and build 

from that. This will give the designer a solid starting point to create the entire remaining parallel pavement 

marking lines. 

 

As mentioned earlier in this chapter, there are four additional tools in D&C Manager to aid in the design and layout 

of pavement marking.  

  



DRAW STRIPING 

 

This Draw Striping tool draws all solid or skip pavement markings. The striping tool can reference a GEOPAK 

chain or an existing MicroStation linear element for length and offsets. The MicroStation elements can be in the 

active file or in a reference file. 

 

The Draw Striping tool has two parts, Pattern and Reference Element, with several preferences for you to set in 

each of the two parts. The following pages detail the Draw Striping tool. 

PATTERN – SINGLE STRIPE OR DOUBLE STRIPE 

Single Stripe A or Single Stripe B options allow two different configurations to be stored in a resource file 

so the type of stripe placed is easily changed. It is a way to set favorites, example; set Single Stripe A to 6” 

solid white and set Single Stripe B to 6” solid yellow. To draw a 6” solid white line set the pattern to Single 

Stripe A or to draw a 6” solid yellow line set the pattern to Single Stripe B.  The Single Stripe draws solid 

and skip lines. 

 



Note When drawing skip lines, it is easier to get the spacing correct by using the end point of the solid line 

that approaches the stop bar, starting on skip and placing the strip in reverse of the driving direction. 

The figure below shows this scenario. 

 

 

Double Stripe allows for four possible configurations set up with a 

combination of Solid/Solid, Skip/Skip, Solid/Skip and Skip/Solid 

markings. The figure shows the Double Stripe A Pattern set up to 

draw a 6” solid yellow line on the Inside and a 6” 10/30 Skip line 

on the Outside with a 0.33’ or 4” Distance Between Stripes. 

This is a typical set up for a two-lane roadway with a passing zone 

on one side, as depicted in the figure below. 

 

 

o Distance Between Stripes – It is the space between two striping lines. This distance is expressed in terms 

of master units. There will be times when the designer will need to use a larger distance between lines 

than what the design standards call for. Example, if the signing and marking plans are at 100 scale a 4” 

separation between two 6” lines is not enough, the two lines appear like one thick line. 

o Tolerance – If the length of a segment of pavement marking is less than the Tolerance, there is no 

placement of the line and only used at the ending point, to determine placement of the final piece of 

marking. 

  



REFERENCE ELEMENT – DGN OR CHAIN  

The Draw Striping tool uses Reference Elements to create/draw parallel lines and arcs.  

 

o Reference Type – Drop down options to select the type of reference element to use, DGN or Chain. 

� DGN – This can be any MicroStation element like the edge of pavement line or another striping 

line. When you select DGN, there are three options when selecting a MicroStation element: 

� Single Element – When selected, use the Identify DGN Element button to select the element. 

The stationing begins at 0.00 and the length of the element selected determines the end. 

� Complex Chain – Select the option, which invokes the MicroStation Create Automatic 

Complex chain tool to define the elements. Stationing begins at 0.00 and is based on the length 

of the selected element. This option does not work with elements in a reference file. 

� Selection Set – This option works with elements in the active file or in a reference file. Create 

the selection set, and then set the toggle to Selection Set.  Click Accept Selection Set, which 

computes the stationing for the selection set. The MicroStation PowerSelector works very 

well for creating the selection set. 

� Chain – This is a GEOPAK chain stored in the GPK. Select the chain from the list or graphically 

with Identify Chain. Stationing fields are automatically populated. The values may be changed 

manually or graphically using the Beg and End buttons. 

o Begin – Identifies the beginning of the striping. If using DGN element, this field will start at a value of 

0.00 or the value of the length of the line selected depending on how the element was created. Enter a 

value in the field to start the striping at a point other than the beginning of the line. If Station is used the 

begin station of the chain will be the value. 

The figure below shows the reference line used which is 300’ long along with the new line created 33’ 

to the right of the beginning point. The reference line is, a reference, it does not have to control the length 

of the new striping line created. 

 



o End – Identifies the end of the striping. If using DGN 

element, this field will start at a value equal to the length 

of the line or 0.00 depending on how the element was 

created. Enter a value in the field to end the striping at a 

point other than the end of the line. If Station is used the 

end station of the chain will the value.  

The figure shows the Chain option. Notice the Begin and 

End values are populated with the beginning and ending 

station values of the selected chain.  

o Offset – This is the offset from the selected element, either the Chain or DGN element, to the new 

striping line. It is not necessary to use plus or minus values, simply graphically indicate the side by 

moving the cursor to the left or right. 

o Draw Stripes – This attaches the new striping to the cursor at the defined offset. Just move the striping 

to the desired side of the DGN or Chain. Issuing a Data Point places the new striping in the design file. 

The new striping elements are placed in a graphic group for easy deletion. 

  



Exercise 5.1 Create a Project Specific DDB 

In this exercise, D&C Manager will be used to create a project specific DDB. A project specific DDB gives the 

designer the capability to modify DDB items for their specific project, if necessary, providing flexibility and 

advantages in production, multi-designer/discipline usage and project to project portability for common District/job 

related items.  

1. Open the file C:\e\projects\22049555201\signing\Dsgnsp01.dgn. (This is the main design file for all 

signing and pavement marking elements.) 

2. From the MicroStation Menu, select GEOPAK > ROAD > Design & Computation Manager to open 

D&C Manager. This should load the FDOTSS4.ddb file. 

 

3. From D&C Manager select File > Save As > New File. 

 

4. Navigate to the project symb folder.  



5. Rename the file as 22049555201.ddb and click OK. 

 

6. From D&C Manager select File > Open and navigate to the saved DDB file in the symb directory.  Select 

the file and click Open. 

 

  



Exercise 5.2 Draw Crosswalk Markings 

� Placing Special Emphasis Crosswalk Markings (Part 1) 

In this exercise, use the D&C Manager to draw the solid pavement markings for the Special Emphasis 

Crosswalks. The process will start by placing the outside edge lines using construction lines in the DSGNRD file 

as the reference elements. Use the D&C Manager and other MicroStation tools to place the longitudinal lines. 

This exercise utilizes Thermoplastic items as well. 

Note For the expediency of the class, with the use of MicroStation tools, the construction lines are drawn for 

all of the Pavement Marking for the new NW corner of the intersection with the curb island. . 

1. Continuing in the Dsgnsp01.dgn, attach the reference files Algnrd01.dgn (Algnrd_50 model), and 

Dsgnrd01.dgn (Default model) from the Roadway folder. 

2. Zoom into the island on the left side of the SR61 alignment between Stations 700+00.00 and 701+00.00.  

3. Use MicroStation tools to rotate the view so the SR61 Alignment is going left to right.  

 

4. Reference the Dsgnrd01.dgn file, ConstructionLines Model.  

5. If D&C Manager is not open, from the MicroStation Menu, select GEOPAK > ROAD > Design & 

Computation Manager to open D&C Manager.  Make sure to open the project ddb, 22049555201.ddb, 

file saved in the symb directory. 



6. From D&C Manager, select Pavement Markings > Thermoplastic > Standard > Solid > LF > 0711 

11123 Thermo., Std., White, Solid, Crosswalk/RA, 12". 

  

7. From D&C Manager, click on the Pavement Markings Program button . This appends the 

Pavement Markings Program tools to the D&C Managers button bar. 

8. From D&C Manager, click on the Striping button . to open the Draw Striping tool. 

a. Set the Pattern to Double Stripe A.  

b. Click the Inside and Outside buttons to set the striping DDB item. 

c. Set the Distance Between Stripes to 7.00.  (Minimum width =6’ + 6” x 2 to centerline of striping 

each side. See Design Standards, Index 17346.)  

d. The type of line should be set to Solid/Solid.  

e. Set the Reference Element to DGN. 

f. Select Single Element from the Reference Type drop down list. 

g. Click the Identify DGN Element button and select the yellow construction line between the 

island and the right edge of pavement.  

h. Set the Offset to 0.00. It is not necessary to use a plus or minus with this tool. 



i. Click the Draw Stripes button. 

 

9. Place a Data Point. 

10. Do Not Close the Draw Striping dialog. 

Note It is not necessary to close the Draw Striping tool to select a different item, go back to D&C 

Manager and select a new item then click the Single button to make it active or double click on the 

new item in D&C Manager. 

11. Perform a little cleanup work on the 2 lines just placed with the Trim to Element  MicroStation 

Tool. Click on each end of the lines and the adjacent edge of pavement to extend or trim the lines. 

12. Repeat steps 8-11 at the other 2 cross walk locations in the intersection. 

13. Do Not Close the Draw Striping dialog. 

  



� Placing Special Emphasis Crosswalk Markings (Part 2) 

1. Rotate view so the large crosswalk crossing SR 61 is horizontal across the screen. 

2. In MicroStation, select the Place Smartline  tool. 

3. In the D&C Manager, select the Design tool . 

4. Double click the Pavement Markings > Thermoplastic > Preformed > Solid > 0711 14125 Thermo., 

Preformed, White, Solid, 24” for the longitudinal crosswalk pavement markings. 

 

Note Double clicking on a DDB item sets Place Influence in the D&C Manager and activates the key-in 

command to “construct perpendicular from”. 

5. Snap (1) to the end of crosswalk line at the 

furthest station at the island. 

6. Snap (2) to the end of crosswalk line at the 

closest station at the island.  

7. Using the Move Parallel command, Snap (3) to 

the bike lane line to the right.  This places the 

initial 24” longitudinal crosswalk line at the 

bike lane. 

 

 

8. Use the MicroStation Copy Parallel tool to copy the initial 24” longitudinal crosswalk line 11.5’ and 

then again 12’ to the right to line up with the adjacent lane lines. (Or toggle off the Distance and snap to 

the construction lines at the lane line locations.) 



9. Continuing with MicroStation Copy Parallel, copy the longitudinal crosswalk line across the intersection 

using the construction elements for locations. 

Note To this point, the longitudinal crosswalk lines have been drawn at the lane line locations per the standard 

index.  Next there needs to be longitudinal crosswalk lines drawn ½ way between the lane lines with 

maximum of 60” (5’) between the edges of paint.  This equates to a maximum of 7’ between the 

centerline of the markings. For 12’ lanes copy the lines parallel 6’. 

10. Copy the lines found to the left of the travel lanes 6’ to the right (or 5.75’ for the 11.5’ marked lanes).  

 

 

11. Perform a little cleanup work on the longitudinal lines with the Trim to Element  MicroStation Tool. 

Click on each end of the lines and the adjacent edge of pavement to extend or trim the lines, if needed. 

  

   

  



Exercise 5.3 Draw Solid Yellow Striping 

� Placing Solid Yellow Striping (Part 1) 

In this exercise, use D&C Manager to draw the solid pavement markings. The process will start by placing the 

right inside edge line using the right inside traffic separator line and the right inside curb face line as the reference 

elements. Thermoplastic items will be used in this exercise. 

1. Continuing in the Dsgnsp01.dgn file, zoom in near STA. 704+00. This is where the inside edge lines are 

located. 

2. Rotate the view so the alignment is left to right on the screen. 

3. From D&C Manager click the Pavement Marking button . This activates four additional pavement 

marking tools. 

 

4. From D&C Manager navigate to the Pavement Markings > Thermoplastic > Standard > Solid > GM 

>  Open Graded Asphalt category. 

Hint From the Edit menu in D&C Manager, there is a search tool to aid in finding a 

category or item within D&C Manager. To launch the search tool select Edit > Find. 

5. Select the Item 0711 15201 Thermo., Std. - Open Grade, Yellow, Solid, 6". 

 

6. From D&C Manager, click on the Striping button  to open the Draw Striping dialog. 

7. Set the Pattern to Single Stripe A.  

8. Click on Single to set the active item. 

9. The type of line should be set to Solid. (This is automatically set to solid because the item in D&C Manager 

was created with the key word Solid in the description.)  



10. Set the Reference Element to DGN. 

11. Select Single Element from the method drop down list. 

12. Click the Identify DGN Element button and select the top Traffic Separator line.  

13. Set the Offset to 0.5. This offset is for display purposes.  2” is required per Design Standard Index 17346 

pg. 2 of 14. 

14. Click the Draw Stripes button. 

15. Move your cursor above the traffic separator line and place a Data Point. 

16. On the Draw Striping dialog, change the Reference Element DGN method to Selection Set. 

17. Click the Identify DGN Element button and select the inside edge of pavement lines above the centerline. 

When all elements are selected click the Identify DGN Element button again. This will set the begin and 

end values which is the total length of all elements combined. 

18. Set the Offset to 0.5. Again, this offset is for display purposes.  

19. Click the Draw Stripes button. 

20. Move your cursor above the edge of pavement line and place a Data Point. 

21. Use the Trim Elements to Intersection tool to clean up the drawn lines. 

 

22. Do Not Close the Draw Striping dialog. 

Note It is not necessary to close the Draw Striping tool to select a different item, go back to D&C 

Manager and select a new item then click the Single button to make it active or double click on the 

new item in D&C Manager. 

23. Continue to place the inside edge line pavement markings throughout the rest of the project if class time 

permits. 

  



� Placing Solid Yellow Striping (Part 2) 

1. Continuing in the Dsgnsp01.dgn file, zoom in near STA. 701+00.  

2. Zoom in to the Traffic Separator Nose at Sta. 701+00. 

3. Select the construction lines forming the separation outline in front of 

the traffic separator nose into a selection set. 

4. In D&C Manager, select Item 0711 15201 Thermo., Std. - Open 

Grade, Yellow, Solid, 6". 

5. Set the Pattern to Double Stripe A. 

6. Click the Inside and Outside buttons to set the selected item for both 

fields. 

7. Set the Distance Between Stripes to .33 (4”). 

8. Leave type of line set to Solid/Solid. 

9. Set the Reference Element to Selection Set. 

10. On the Draw Striping tool, click the Identify DGN Element button. This sets the Begin and End values. 

11. Set the Offset to 0.0. 

12. Click Draw Stripes.  

13. Data Point in the screen. 

 

14. Continue to place the inside separation edge line pavement markings throughout the rest of the project if 

class time permits. 

  



Exercise 5.4 Draw Stop Line 

In this exercise, the student will use D&C Manager to place a stop bar. The Stop Bar item in D&C Manager has the 

Construct Perpendicular command built into it. When using the D&C Manager, always read the MicroStation status 

bar for hints. 

1. Continuing in Dsgnsp01.dgn, zoom to near Sta. 700+60. 

2. Rotate view as needed. 

3. Open D&C Manager and navigate to the category Pavement Markings > Thermoplastic Pavement 

Markings > Standard > LF. 

4. Double click on Item 0711 11125 Thermo., Std., White, Solid, 24”. Read the message field in 

MicroStation. 

 

5. Snap to the intersection of the yellow edge line and the yellow construction line placed where the stop bar 

needs to be placed for the start point. Moving the cursor will show the direction in which the line will be 

drawn.  Right click if needed to draw the line across the lanes. 

Note The construction line is drawn 5.5’ from the 12” cross walk line.  This accounts for the 4’ gap required 

between the stripes plus the distance from centerline of the stripes to the edge of stripe. 

6. Snap to the white lane line near the island for the end point.  

7. Turn Off Place Influence. The figure below shows the stop bar placed. 

 

8. Finish placing the Stop Bar in other areas throughout the class project. 

  



Exercise 5.5 Draw Solid White Turn Lane Line Stripe 

� Placing Solid White Turn Lane Line Stripe 

In this exercise, D&C Manager will be used to draw the 6” solid white lane line for the left turn lane. Refer to 

index 301 for turn lane design criteria and index 17346 for special markings in turn lanes.  

1. Continuing in Dsgnsp01.dgn zoom into the area of the left turn lane (station 701+00 to 704+00) so you 

can see the entire turn lane and rotate view accordingly. 

  

Note The construction lines have been drawn to include 2 lines.  One line for the solid white stripe and the 

second 85’ line for the 6/10 dotted line.  The 85’ is clearance distance L1 from the table on index 17346 

based on a 45 (mph) design speed.  

2. In D&C Manager, select the Draw Striping tool and select Item 0711 15101 Thermo., Std. - Open Grade, 

White, Solid, 6". 

3. Set the Pattern to Single Stripe A. 

4. Click the Single button. This will set the selected item from D&C Manager. 

5. Set the Reference Element to DGN and Single Element. 

6. Click the Identify DGN Element button. 

7. Select the construction line for 

the turn lane line.  Data point 

again in the screen to accept the 

selection. 

8. Set the Offset to 0.0. 

9. Click Draw Stripes and place a 

Data Point to accept the drawn 

lines. 

10. Take a moment to review the 

pavement markings.  

 

11. Continue to place the Turn Lane Line Pavement Marking throughout the rest of the project if class time 

permits. 

  



Exercise 5.6 Draw 6/10 White Dotted Stripe 

� Placing 6/10 White Skip Stripe (Part 1) 

In this exercise, you will complete the turn lane striping by placing a 6” white 6/10 skip line from the beginning 

of the turn lane to the 6” solid lane line using the remaining construction line. 

1. In D&C Manager, select Item TP_6_10Wgm Thermo., Std., White, Dotted Ext, 6" (6/10) located in 

the category Pavement Markings > Thermoplastic > Guide Lines. 

2. In the Draw Striping dialog continue with the Pattern set to Single Stripe B. 

3. Click the Single button to set the item active. 

4. Set the stripe type to Skip. Set to Start on Skip.  

5. Set the Stripe length to 6.0 and the Skip length to 10.0. 

6. Set the Reference Element to DGN and Single Element. 

7. Click the Identify DGN Element button.  

8. Identify the construction line at the end of the turn after the solid white line placed in the previous exercise. 

Data point in the screen to accept the element. 

 

9. Click Draw Stripes. 

Note You can adjust the begin and end points by using the vcr buttons to achieve the desired first stripe line. 

10. Place a Data Point and reset to cancel the command. The figure below shows the finished skip stripes. 

Later in this chapter you will place left turn arrows in this turn lane. 

  

11. Continue to place the 6” white 6/10 skip stripe throughout the rest of the project if class time permits. 



Exercise 5.7 Draw Bike Lane Striping 

� Placing Solid White Striping for the Bike Lane (Part 1) 

In this part of the exercise, D&C Manager Draw Striping tool will be used to draw the solid white Bicycle Lane 

line.  Use the Design Standards Index 17347 for guidance on bike lane marking criteria.  This exercise uses detail 

KH-2, Intersection with Right Drop Lane, Curb and Gutter Section. 

 

1. Continuing in Dsgnsp01.dgn, select the D&C Manager item 0711 15101 Thermo., Std. - Open Grade, 

White, Solid, 6". 

2. Set the Pattern to Single Stripe A.  

3. On the Draw Striping dialog, click the Single button to make the item active. 

4. The type of line should be set to Solid.  

5. For the Reference Element change the option to DGN.  

6. Set the type of element to Single Element.  

7. Click the Identify DGN Element button and select the construction line crossing the stop line by the curb 

island.  Data Point to accept.  (Line marked 1 in figure below.) 

 

 

8. Set the Offset to 0.0. 

9. Click the Draw Stripes button. 

10. Data Point to accept the placement of the line. 

11. Repeat steps 7-10 for the line marked 2 in the figure above. 

12. Continue to place the bicycle lane down the right side of the roadway 

by selecting the edge of pavement lines with an Offset of 4’. 

  



� Placing Guide Line White Striping for the Bike Lane (Part 2) 

In this part of the exercise, D&C Manager Draw Striping tool will be used to draw the 2/4 white guide line 

required for the Bike Lane. 

1. Zoom into the beginning of the Bicycle Lane at the beginning intersection. 

2. In D&C Manager, select Item TP_2_4Wgm Thermo., Std., White, Guide Line, 6" (2/4). 

3. In the Draw Striping dialog set the Pattern to Single Stripe B. 

4. Click the Single button to set the item active. 

5. Set the stripe type to Skip. Set to Start on Skip.  

6. Set the Stripe length to 2.0 and the Skip length to 4.0. 

7. Set the Reference Element to Single Element and select the construction line for the bike lane skip striping 

closest to the curb island. 

8. Click the Draw Stripes button. Data point to accept the placement of the lines. 

9. Click on the Identify DGN Element button and select the construction line for the bike lane skip striping 

on the other side of the 30’ gap.  Data point to accept the element. 

10. Modify the Begin and End values to begin at 50.00 and end at 0.0. 

 

11. Click the Draw Stripes button. Data point to accept the placement of the lines. 

12. Review the markings. 

 



Exercise 5.8 Draw Lane Line – Solid & 10/30 Skip Stripe 

� Placing 10/30 Skip Stripe (Part 1)  

In this exercise, you will use the D&C Manager Draw Striping tool to place the white solid and 10/30 skip line 

for the through lane at the intersection.  

Note This tool can be used to place multiple lines simultaneously.  This will depend on the distances between 

where the lines placed are identical offset distances.   

1. Continuing in Dsgnsp01.dgn zoom to near Sta 701+00.  

2. Rotate view accordingly. 

3. Set the Pattern to Single Stripe B.  

4. Select the D&C Manager item 0711 15101 Thermo., Std. - Open Grade, White, Solid, 6". 

5. Set the Reference Element to Single Element. 

6. Click the Identify DGN Element button and select the outside lane line which turns into the center line of 

the 2 lanes approaching the intersection.  Data point to accept the element. 

7. Set the Begin to 0.0. 

8. Set the End to 50.0.  (This is the minimum distance for the solid line when approaching an intersection.  

See Index 17346.) 

9. Set the Offset to 0.00. 

 

10. Click the Draw Stripes button.  Data point to accept the placement of the line. 

11. Move your cursor to the left side of the element and place a Data Point. 

 

  



� Placing 10/30 Skip Stripe (Part 2) 

In this exercise, place the single white 6” 10/30 Skip. 

1. On the Draw Striping tool set the Pattern to Single Stripe B. 

 

2. In D&C Manager, select Item TP_10_30Wgm Thermo., Std. - OG, White, Skip, 6" (10/30) from the 

Pavement Markings > Thermoplastic > Skip/Dotted > Open Graded category. 

3. Set the Line Type to Skip. 

4. Set to Start on Skip.  

5. Set the Stripe length to 10.0. 

6. Set the Skip length to 30.0. 

7. Set the Reference Element to DGN. 

8. Select the same line from previous exercise. 

9. Set the Begin to 80.0.  (This is the 50’ length of solid stripe placed previously.) 

10. Set the Offset to 0.0. 

11. Click the Draw Stripes button.  Data point to accept the placement of the line.  

12. Zoom out to view both sides of the road. 

  



� Placing 10/30 Skip Striping (Part 3) 

In this exercise, the SR61 alignment will be used as the reference chain to add the 10/30 Skip Striping to the other 

side of the road between the 2 travel lanes. 

1. On the Draw Striping tool, ensure that the Pattern is set to Single Stripe B. The pay item data should still 

be set to 10/30 skip.  

 

2. Set to Start on Stripe.  

3. Set the Reference Element to Chain. 

4. Select the CLCON from the drop down list. 

5. Set the Begin Station to 700+78.36.  (This is the station 30’ beyond the crosswalk.) 

6. Set the End Station to 714+44.10.  (This is the end of the 10/30 Skip before the side street intersection.) 

7. Set the Offset to 23.00. (This is the offset distance from the CLCON reference chain to the lane line the 

10/30 Skip is being placed.) 

8. Click the Draw Stripes button. Move your cursor in between the edge lines and place a Data Point and 

reset to cancel the command.  Take a moment to review the striping lines, turn the reference files off to 

better see the line work. 

 



DRAW CELL GROUP BY FEATURE 

The Draw Cell Group by Feature tool can be used for placing Pavement Messages and Arrows, RPM’s or any 

other cell you want to group together. It is not required to use this tool when placing cells, however, this tool will 

make the task of drawing Arrows and RPMs much easier. This tool can be opened on the Road tools pallet or on 

the menu GEOPAK > ROAD > Plans Preparation > Draw Cell Group by Feature. 

Note When using the Draw Cell Group by Feature and/or Draw Cell by Feature tools, always ensure to load 

the correct GEOPAK DDB as the tool will 'reset' to the DDB specified in the resource file every time 

the tool is closed and reopened.  This GEOPAK DDB may not be the DDB intended for use with your 

active project. 

The dialog consists of two tabs: 

FEATURE GROUP TAB 

Feature Group defines the D&C Manager item(s) to use, which in turn selects the cell(s) to be placed, and 

the Offset from the selected element to place the item. 

 

Based on the items that are checked the tool allows the designer to place up to three different cells. The 

Magnifying glass next to each item allows the designer to browse to D&C Manager and select the appropriate 

item, which will attach the cell to be drawn. The Offset is the distance from the selected DGN Element or 

Chain when drawing the cell. 

LOCATION TAB 

Location defines whether to use a DGN element or Chain, Begin and End stations, Spacing, Angle, and 

Justification. 

  



o Element – This is either a GEOPAK Chain or DGN element. This function is similar to the Draw 
Striping tool. The Begin and End fields will be populated with the appropriate data based on the element 

selected. They can be modified using the buttons or by keying in the value. 

o Buffer Distance – This is for setting where to start the first cell and end the last cell. Example, when 

placing RPM’s on a 10/30 skip line, if snapping to the beginning of the first painted stripe, set the Begin 

Buffer Distance to 25.0. This accounts for the 10’ (ft) stripe and the 15’ (ft) spacing between the first 

and second stripe. 

 

o Spacing – There are several options available to set the spacing between the cells, they are: 

� Increment – This is a set value between cells. 

� Even – Evenly spaces the cells at a user-specified spacing, the buffer distances are ignored. 

� Max Spacing – The location of the beginning and ending cell are determined, then a sufficient 

number of cells are placed in between, so that the distance between them is no more than the 

specified Max Spacing and equidistant apart. 

� Once – Only one set or cell is placed. The ending buffer distance is ghosted. 

� Each Vertex – The origin of the cell is placed at each vertex of the selected element. The Begin 

and End and buffer distances are ghosted. 

� End Points – The origin of the cell is placed at each end point of the selected element. The Begin 

and End and buffer distances are ghosted. 

Hint When placing RPMs along a curved roadway this tool does not account for the 

curve geometry at an offset. You will have to copy parallel one of the edge lines on 

top of the 10/30 skip line and use that line as the DGN element then delete the copied 

line. Optionally, the Chain option can be used if the cells can be placed parallel to the 

selected alignment. 

o Angle – If set to Absolute the angle is based on 0 degrees as horizontal. If set to Relative the cell is 

placed relative to the element selected. 

o Justification - The justification can be based on the center cell (only option if only one row is placed), 

the upstream or downstream cell.  Only those selected in the Feature Group are available for setting 

Justification. 

  



Exercise 5.9 Place RPM’s - Draw Cell Group by Feature  

� Place RPM’s using Draw Cell Group by Feature – Feature Group Tab (Part 1) 

In this exercise, the student will place RPMs along the 10/30 skip line previously drawn.  

1. Continuing in Dsgnsp01.dgn open the Draw Cell Group by Feature tool. This tool can be opened on the 

Road tools palette or on the menu Applications > GEOPAK ROAD > Plans Preparation > Draw Cell 

Group by Feature, or from the Draw Cell option on the FDOT Plans Development > Traffic Plans task 

menu. 

2. On the Feature Group tab, click on the Browse Features (Category) icon in the center of the dialog to 

open Select Design & Computation Manager Payitem. 

 

3. In Select Design & Computation Manager Payitem dialog navigate to Pavement Markings > 

Pavement Markers and select the Item RPM_WR Retro-Reflective Pavement Marker (W/R). 

 

Note It is not necessary to select the exact item needed.  This sets the category to populate the drop down 

list available on the Feature Group tab of the dialog. 

4. Click the OK button or double click on the item in D&C Manager. This will close D&C Manager and 

set this category in the Feature Group tab. 

5. Using the drop down arrow, select the RPM_WR Retro-Reflective Pavement Marker (W/R). 

6. Set the Offset to 23.0.  

7. Click on the Location tab. 



� Place RPM’s using Draw Cell Group by Feature – Location Tab (Part 2) 

In this part of the exercise, you will copy the 6” white bicycle lane line over 12’ and complete the Location tab 

of the Draw Cell Group by Feature tool. 

1. Continuing in Dsgnsp01.dgn, zoom in to the intersection near station 701+00. 

2. Continuing on the Location tab of the Draw Cell Group by Feature tool, set the Element to Chain. 

3. Select the chain CLCON from the drop down list. 

4. Set the Begin Station to 700+48.36.  (This is the station at the crosswalk.) 

5. Set the End Station to 714+44.10.  (This is the end of the 10/30 Skip before the side street intersection.) 

6. Set the Offset to 23.00. (This is the offset distance from the CLCON reference chain to the lane line the 

10/30 Skip is being placed.)  

7. Set the Begin Buffer Distance to 15.0. This is the distance of half the skip distance (30 ft) to ensure the 

RPM will be placed centered in the skip between the 10ft skip stripe lines. 

8. Set the End Buffer Distance to 0.00. 

9. Set to Increment and enter 40.0. This is the spacing between the RPM’s. 

10. Angle should be 0.00 and Relative. 

11. Set the Justification to Center Cell and Origin. 

 

12. Click Draw and move the pointer over the skip lines and place a Data Point. You should now see RPMs 

centered between the skips. 

13. Take a moment to review the reflective pavement markers.  Do not close the Draw Cell Group by Feature 

dialog; need for the next exercise. 

14. Continue to place the rpms on the remaining 10/30 skip placed in previous exercises. Keep in mind the 

technique used in this exercise and how the 10/30 skip was placed in the previous exercise. 

  



Exercise 5.10 Place Turn Arrows - Draw Cell Group by Feature  

In this exercise, the Draw Cell Group by Feature tool will be used to draw turn arrows in the left turn lane worked 

on earlier in this chapter. When placing turn arrows and pavement messages refer to index 17346 for placement and 

spacing details. This exercise uses the 6” white lane line as the reference element to place the turn arrows.  

1. Continuing in Dsgnsp01.dgn, zoom to the turn lane at the intersection at the beginning of the project. 

2. Rotate view as needed. 

 

Note Due to a quirk in how this tool works, if using the relative option, do not rotate the view to the same angle 

as the reference element.  The cells may come in backwards. 

3. On the Feature Group tab, click on the Browse Features (Category) icon in the center of the dialog to 

open Select Design & Computation Manager Payitem. 

4. On Select Design & Computation Manager Payitem navigate to Pavement Markings > 

Thermoplastic > Standard > Arrows > TP_DALeftTurn Thermo., Std., Arrows (Left). 

Note You can use the search function to locate items if you know the pay item number or description. 

  

5. Either Double Click on the item in D&C Manager or click the OK button. 



6. Next to the Browse Features (Category) icon , click the drop down menu and select the Left Directional 

Arrow. This will load the appropriate cell. 

  

7. Set the Offset to 6.0. (This is the distance from the reference element used to place the turn arrows; you 

must also take into account the cell origin if it is not in the center of the cell.) 

  

8. On the Location tab set Element to DGN. Use the 6” white lane line as the reference element. 

9. Click the Identify DGN element button and select the 6” white lane line. Make sure and select the line 

near the entrance of the turn lane. 

10. Notice the End distance value is 305.13’, based on the details on Index 17346 any turn lane longer than 

200’ the designer is to add one arrow for each additional 100’. This means the turn lane in this exercise 

requires four arrows total. 

11. Set the Begin Buffer Distance to 15.00. 

 

 

 

 



 

12. Set the End Buffer Distance to 30.7.  (This is the 

distance from the end of the white edge line or stop line 

to the origin of the turn arrow cell to get the required 25’ 

distance from the end of the lane line or stop line to the 

point of the arrow.) 

 

 

13. Set the Spacing to Max Spacing. (To maximize the cell placement along the selected reference element.) 

14. Set the Spacing distance to 100.0. 

15. Set the Angle to 0.0. 

16. Set Rotation to Relative.  

17. Set Justification to Center Cell and Origin. 

 

 

18. Click Draw and move the pointer into the turn lane and place a Data Point. 

19. Close the Draw Cell Group by Feature tool. The figure below shows the completed turn lane. 

  

 

  



CHEVRON SEPARATION 

  

 

Another Pavement Marking tool is the Draw Separation tool. This tool allows you to draw stripes at an angle 

between elements such as a center turn lane where it approaches a left turn condition. 

 

o Item – This is the pay item selected in D&C Manager. Clicking the Item button loads the selected item 

from D&C Manager. 

o Distance Between Stripes - Refer to the indexes for the correct distance between stripes. 

o Slash Stripe Angle – This is the angle, in degrees, of the stripe. 

o Fixed - Stripes are placed parallel to the first stripe (relative to the Reference Point), even in non-

tangential areas. 

o Variable - The angle is maintained between the stripe and the location side, even around curves. 

o Begin Point - Identifies the beginning of the striping. Note: Begin does not have to be on the element 

(but inside the striping area) as the software constructs perpendicular to the element and utilizes the 

projection by utilizing Begin (and End), the length of the striping is determined by the designer, not the 

length of the chain. Note: If the beginning area is in a gore, DO NOT snap to the gore itself, as the point 

must be inside the striping area. 

o Reference / Pivot Point - Point projected onto the Side 1 element and the first marking is placed. The 

placement of all other markings in this processing are placed relative to this first stripe. 

o End Point - Serves the same function as Begin, but at the opposite end. 

o Side 1 - In order to place the pavement markings correctly, you must understand the difference between 

Side 1 and Side 2. Side 1 is the termination side of the stripe or where the marking stops. 



o Side 2 - Side 2 is utilized when turning the Slash Stripe Angle. The software begins on Side 2, and draws 

the marking at the specified angle until it intersects the Side 1 element, where the marking stops. It is 

also desirable to have the total length of the Side 2 elements longer than the Side 1 elements; however, 

it is not mandatory. Three methods are supported to define the elements.  It is not necessary to use the 

same method on both sides. 

o Selection Options – There are three options for selecting the side elements in MicroStation: 

� Single Element – When selected, you are prompted to select the element. 

� Selection Set – If the selected elements are in reference files, this method must be utilized, as 

Complex Chains cannot be selected from reference files. Create the selection set, and then set the 

toggle to Selection Set.  Click Identify DGN Element to accept the selection set. 

� Complex Chain – Select the option, which invokes the MicroStation Create Automatic 

Complex chain tool to define the elements. 

o Draw Separation - By moving the cursor on the screen, the designer can move the striping to the desired 

angle side (90 degrees), and a Data Point places the striping into the MicroStation file. The striping is 

placed (with each Data Point) in a graphic group for easy deletion, if desired. 

Exercise 5.11 Draw Separation 

In this exercise, you will draw an 18” Yellow separation lines using the Pavement Marking tool Draw Separation. 

1. Open Dsgnsp-Stripe.dgn, Separation Model, in the Signing folder. 

2. Open D&C Manager and select the Pavement Marking mode. 

3. Navigate to Pavement Markings > Thermoplastic > Standard > Solid > LF and select Item 0711 11224 

Thermo., Std., Yellow, Solid, Diag./Chevrons, 18". 

4. On D&C Manager, select Separation from the Pavement Marking tools to open Draw Separation. 

 



a. Set the Distance Between Stripes to 10.0. Refer to Index 17346 for spacing and angle criteria. 

b. Select Fixed for the stripe angle. 

c. Set the Slash Stripe Angle to 45.0. 

d. Set the Begin Point, Reference / Pivot Point, and End Point as shown in the figure. Use the VCR 

buttons next to each option before snapping to the lines.  

e. Use the tentative snap to select the end point of each line.  

 

f. For Side 1 set the option to Selection Set.  

g. Using Power Selector to select both lines representing Side 1, see figure above. 

h. Once both lines are selected, click the Accept Select Set button next to the Side 1 option. 

i. Clear the selection set from Power Selector. 

j. For Side 2 set the option to Single Element. 

k. Click the Identify DGN Element button. 

l. Select Side 2 as seen in figure above. This is a two-click process; select and accept. 

m. Click Draw Separation and move the cursor onto the screen, adjust the striping by moving the 

mouse left and right until the desired rotation is present. 

5. Place a Data Point to draw the stripes. The figure below shows the finished product. The stripes are placed 

in a graphic group for easy deletion. 

 

6. Close the Draw Separation tool. Do Not Close D&C Manager. 

7. There are areas in the class project that require separation pavement striping. If time permits, try this 

technique on the class dataset. 

  



CHEVRON DIVERGE 

 

The DrawChevron Diverge tool is used for traffic channelization 

at a gore when traffic flows in the same direction as seen in the 

figure below. Refer to Index 17346 for specific design criteria. 

 

 

o Item – This is the pay item selected in D&C Manager. 
Clicking the Item button loads the selected item from D&C 
Manager. 

o Distance Between Chevrons – Refer to the indexes for 

the correct distance between stripes. 

o Tolerance - If the length of a segment of pavement 

marking is less than the Tolerance, the line will not be 

placed. It will only be utilized at the ending point, to 

determine where the final piece of marking is placed.  

o Gore Point (Wide End of Gore) – Identifies the wide end of the gore. 

o Breaking Line – Placed between the two sides and is used to draw the chevron. This can be adjusted 

during the drawing process to obtain the best scenario. 

o Diverge Point (Narrow End of Gore) – Identifies where the chevron stops at the narrow end of the 

gore. 

o Side 1 – Is the intersecting side where the stripe stops. 

o Side 2 – Is utilized when turning the Slash Stripe Angle. The software begins on Side 2, and draws the 

marking at the specified angle until it intersects the Side 1 element, where the marking stops. It is also 

desirable to have the total length of the Side 2 elements longer than the Side 1 elements; however, it is 

not mandatory. 

o Selection Options – There are three options for selecting the side elements in MicroStation: 

� Single Element – When selected, you are prompted to select the element. 

� Selection Set – If the selected elements are in reference files, this method must be utilized, as 

Complex Chains cannot be selected from reference files. Create the selection set, and then set the 

toggle to Selection Set.  Click Identify DGN Element to accept the selection set. 

� Complex Chain – Select the option, which invokes the MicroStation Create Automatic Complex 

chain tool to define the elements. 

o Draw Chevron Diverge – Displays the striping and the diverging line. A Data Point draws the chevron 

and removes the displayed diverging line. The striping is placed (with each Data Point) in a graphic 

group for easy deletion, if desired. 



Exercise 5.12 Draw Chevron Diverge 

In this exercise you will draw 18” White chevrons in gore area. Refer to Index 17346 for specific design criteria for 

your specific project requirements. To aid in the selection of the three pick points you will notice labels with leader 

lines, the end of the leader lines represent the location to snap to when performing this exercise. 

1. Continuing in Dsgnsp-Stripe.dgn, open the model Diverge. 

2. In D&C Manager navigate to Pavement Markings > Thermoplastic > Standard > Solid > LF and select 

Item 0711 11124 Thermo., Std., White, Solid, Diag./Chevrons, 18". 

3. In D&C Manager, click Chevron Diverge. This opens the DrawChevron Diverge tool as shown below. 

The Item should also be set. 

 

a. Click the Item button if the item is not already set. (If you select the correct Item in D&C 

Manager before starting the Chevron Diverge tool the Item is automatically filled in.) 

b. Set the Distance Between Chevrons to 20.0. Refer to Index 17345 for spacing. 

c. Set the Gore Point (Wide End of Gore), Breaking Line, and Diverge Point (Narrow End of Gore) 

as shown in the figure below. Use the VCR buttons next to each option before snapping to the 

lines. These locations were preset to aid in the completion of this exercise, feel free to deviate 

from these points to view the differences in chevron placements. 

 

d. For Side 1 set the option to Single Element. 



e. Click the Identify DGN Element button. 

f. Select the Side 1 element as seen in figure above. This is a two-click process; select and accept. 

g. Repeat the above steps for Side 2 selecting the Side 2 element. 

h. Click Draw Chevron Diverge and move the cursor onto the screen, adjust the striping by moving 

the mouse left and right until the desired rotation is present. 

4. Place a Data Point to draw the stripes. 

5. The figure below shows the finished product. The stripes are placed in a graphic group for easy deletion. 

 

6. Close the Draw Chevron Diverge tool. Do Not Close D&C Manager. 

7. There are areas in the class project that require diverge pavement striping around the island. If time permits, 

try this technique on the class dataset. 

  



CHEVRON MERGE 

 

The Draw Chevron Merge tool is used for traffic channelization 

at a gore when traffic flows in the same direction in a merging 

situation as seen in the figure below. Refer to Index 17345 for 

specific design criteria.  

 

o Item – This is the pay item selected in D&C Manager. 
Clicking the Item button loads the selected item from 

D&C Manager. 

o Distance Between Chevrons – Refer to the indexes for 

the correct distance between stripes. 

o Tolerance - If the length of a segment of pavement 

marking is less than the Tolerance, the line will not be 

placed. It will only be utilized at the ending point, to determine where the final piece of marking is 

placed.  

o Gore / Break  Point (Wide End of Gore) – Identifies the breaking line for the chevron and should be 

located near the wide end of the gore. 

o Merge Point (Narrow End of Gore) – Identifies the point where the chevron stops at the narrow end 

of the gore. The software utilizes the Gore / Break Point, the Merge Point and the intersection of the 

two sides to construct an arc, which demarcates the breaking in the merging chevron. 

o Side 1 – Is the intersecting side where the stripe stops. 

o Side 2 - Is utilized when turning the Slash Stripe Angle. The software begins on Side 2, and draws the 

marking at the specified angle until it intersects the Side 1 element, where the marking stops. It is also 

desirable to have the total length of the Side 2 elements longer than the Side 1 elements; however, it is 

not mandatory. 

o Selection Options – There are three options for selecting the side elements in MicroStation: 

� Single Element – When selected, you are prompted to select the element. 

� Selection Set – If the selected elements are in reference files, this method must be utilized, as 

Complex Chains cannot be selected from reference files. Create the selection set, and then set the 

toggle to Selection Set.  Click Identify DGN Element to accept the selection set. 

� Complex Chain – Select the option, which invokes the MicroStation Create Automatic Complex 

chain tool to define the elements. 

o Draw Chevron Diverge – Displays the striping and the diverging line.  A Data Point draws the chevron 

and removes the displayed diverging line.  The striping is placed (with each Data Point) in a graphic 

group for easy deletion, if desired. 

  



Exercise 5.13 Draw Chevron Merge 

In this exercise the student will draw 18” White chevrons in gore area in a lane merge scenario. Refer to index 17345 

for specific design criteria.  As mentioned earlier, to aid in the selection of the pick points you will notice labels with 

leader lines, the end of the leader lines represent the location to snap to when performing this exercise. 

1. Continuing in Dsgnsp-Stripe.dgn open the model Merge. 

2. In D&C Manager navigate to Pavement Markings > Thermoplastic > Standard > Solid > LF and select 

Item 0711 11124 Thermo., Std., White, Solid, Diag./Chevrons, 18". 

3. In D&C Manager, click Chevron Merge. This opens the Draw Chevron Merge tool as shown below. The 

Item should also be set. 

 

a. Click the Item button if the item is not already set. As mentioned previously, if you select the 

correct Item in D&C Manager before starting the Draw Chevron Merge tool the Item is 

automatically filled in. 

b. Set the Distance Between Chevrons to 20.0. Refer to Index 17345 for spacing. 

c. Set the Tolerance to 0.10. 

d. Set the Gore/Break Point (Wide End of Gore) and Merge Point (Narrow End of Gore) as shown 

in the figure below. Use the buttons next to each option before snapping to the lines. These 

locations were preset to aid in the completion of this exercise.  

  



e. For Side 1 set the option to Selection Set.  

f. Using Power Selector select both lines representing Side 1, see figure above. 

g. Once both lines are selected, click the Accept Select Set button next to the Side 1 option. 

h. Clear the selection set from Power Selector. 

i. For Side 2 set the option to Single Element. 

j. Click the Identify DGN Element button. 

k. Select the Side 2 element as seen in figure above. This is a two-click process; select and accept. 

l. Click Draw Chevron Merge and move the cursor onto the screen, adjust the striping by moving 

the mouse left and right until the desired rotation is present. 

4. Place a Data Point to draw the stripes. The figure below shows the finished product. The stripes are placed 

in a graphic group for easy deletion. 

 

5. Close the Draw Chevron Merge tool.  

 

 

  



FIX ELEMENTS USING D&C MANAGER SET MODE 

The D&C Manager has a Set Mode used to fix elements not drawn with the D&C Manager. Example: a project that 

contains pavement marking items and the designer is trying to run quantities but nothing happens. All of the elements 

are on the correct level but there is no D&C Manager attribute on them.  

Once invoked, the Set command opens the dialog seen below. This dialog allows the designer to set a MicroStation 

element to a D&C Manager item and add Adhoc attributes to those elements. 

              

The workflow of this tool is: 

1. Select the item in D&C Manager. 

2. Start the Set command. 

3. Click the Set button. 

4. Select the element in MicroStation to fix and accept it. 

Note Use selection sets to make it easier to fix multiple items at the same time. 

Note The Adhoc Attribute feature has the same functionality as in Design mode. It is suggested to always 

leave this selected. It will not add or change anything if there are no Adhocs attributes on the pay item. 

The compute method for most pavement marking items are set to Adhoc Attributes.  If they are not set 

to the elements correctly, the elements will not calculate. 

Exercise 5.14 Set MicroStation Elements to D&C Manager Item 

In this exercise, the student will set MicroStation lines to have D&C Manager attributes on them. These lines are 

100% CADD compliant but they will not quantify. This scenario is common when users in an office do not use D&C 

Manager to draw elements into MicroStation. No one has to redraw the lines, only to set them to the appropriate 

D&C Manager item.  

1. Open Dsgnsp-Stripe.dgn in the signing folder. 

2. Open the model Fix Lines. This is set up for this exercise only.  

3. Open D&C Manager to use the search function to locate the item in D&C Manager.  

4. Use the ID button and select the elements in the Fix Lines model.  Notice none of the elements match 

DDB items. 

5. In D&C Manager, select Edit > Find. 



6. In the Database Search dialog set the Find option to Item/Category. 

 

7. In the name field key-in 0711 15101. Make sure to add the space in the name. 

8. Click Start. This will set you on that item and saves having to navigate to it. 

9. Close the Database Search dialog. 

10. On D&C Manager, click the Set icon . This opens the set dialog. 

11. Click the Set button. 

12. Select the 6” White Lane lines and accept them. It is not necessary to go back to the Set button each time. 

13. In D&C Manager set the Item to 0711 15201. 

14. Use PowerSelector and select the yellow edge lines. 

15. Click the Set button. No need to Data Point on the screen to accept the lines with this option; it is done all 

in one step. 

 


